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Introduction 1

This document gives instructions to use the Waters Empower™ software with a PA 800 Plus
system. The PA 800 Plus Empower™ Driver must be installed on the computer with the Waters
Empower" software. For installation instructions, refer to the document: PA 800 Plus Empower™
Driver Release Notes.

This document includes instructions to calibrate the detectors in the PA 800 Plus system.
Instructions for direct control of the PA 800 Plus system using the Waters Empower™ software
are also given.

Note: For instructions about how to use the system safely, refer to the document: Overview
Guide.

The Waters Empower™ software can also be used with the CESI 8000 Plus High Performance
Separation-ESI| Module when a a laser-induced fluoresence (LIF), photodiode array (PDA), or
ultraviolet (UV) detector is installed.

Related Documentation

This document is for users with some knowledge of the Waters Empower™ software. For
information about the general features of the Waters Empower™ software, do this:

* Refer to the documentation supplied with the software.

« In the Empower Start dialog, click @.

+ In any of the Waters Empower™ software windows, click Help.

For instructions about how to use the Waters Empower™ software for a specified capillary
electrophoresis (CE) application, refer to the following application guides:

» Capillary Isoelectric Focusing (clEF) Analysis Application Guide
» Fast Glycan Labeling and Analysis Kit Application Guide
» IgG Purity and Heterogeneity Assay Kit Analysis Application Guide

For a general introduction to the PA 800 Plus system, refer to the document: Overview Guide.

For instructions about PA 800 Plus system maintenance, refer to the document: Maintenance
Guide.

User Guide PA 800 Plus Empower" Driver
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Introduction

Waters Empower ™ Software Terminology for
32 Karat Software Users

We recommend that users who have used the PA 800 Plus system with the 32 Karat software
become familiar with the Waters Empower™ software terms.

Table 1-1 Waters Empower™ Software Terminology for 32 Karat Software Users

32 Karat Software Term

Waters Empower"
Software Equivalent

Description

No equivalents in
32 Karat software

Instrument Method

A method that contains the

system parameters required for
data acquisition. Parameters groups
are general parameters, detector
parameters, and a time program.

Processing Method

A method that contains data processing
parameters.

Reporting Method

A method to create a report that shows
the results of the processing method.

Method

Method Set

A combination of an instrument
method, a processing method, and a
report method. Processing and report
methods are optional.

Sequence

Sample Set Method

A list of samples and related method
sets that is sent to the PA 800 Plus
system for data acquisition. Optionally,
the Waters Empower™ software can

do post-acquisition data processing and
generate reports.

Report

Report

A file that contains information about
the results of the data acquisition.
Reports can also include information
about the organization that generates
the data. The layout and appearance of
a report can be customized and saved
as part of a report template.

Sample Tray

Plate

The tray or 96-well plate that holds the
samples to be analyzed.

Buffer Tray

Plate

The tray that holds the vials that contain
the buffer and rinse solutions.

PA 800 Plus Empower" Driver
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Introduction

Table 1-1 Waters Empower™ Software Terminology for 32 Karat Software Users

(continued)

32 Karat Software Term

Waters Empower"”
Software Equivalent

Description

Controller

LAC/E module

The computer that controls the PA 800
Plus system.

PA 800 Plus Empower " Driver License

To collect and analyze data with the PA 800 Plus Empower™ Driver, a USB license key is
required. Install the USB license key in a USB port on the Waters Empower™ software LAC/E

acquisition server.

If the license key is not present, then all of the controls in the Direct Control pane are disabled.
Also, data acquisition will not start. If the license key is removed during data acquisition, then
acquisition for the active method set completes but no additional data acquisition will start.

If required, then the license key can be removed from one LAC/E acquisition server and installed
in a USB port on another computer.

User Guide
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Direct Control

2

This section shows how to use the Direct Control pane in the Waters Empower™ software to
control the PA 800 Plus system.

The Direct Control pane has the following three sections, from top to bottom:

* Instrument status pane: Shows the status of the system. Refer to the section: Instrument
Status in the Direct Control Pane.

+ Status field: Shows the status of the system or any process that occurs on the system. Error
messages are also shown in red text in this field.

* Parameter tabs and buttons: Set the parameters for the system. Different tabs show for
different detectors. Refer to the section: Parameters and Buttons in the Direct Control Pane.

Figure 2-1 Direct Control Pane (PDA Detector)

Control Temperature

Tray

Voltage  0.000 kV| Cartnidge 256 °C Bil: Al
Current  0.000 pd| Storage 250 °C BO: --

Paowerer 0 W

Pressure Coolant
00psi o+ oK

Lamp Hrs

Lamp D2:  7.00h

On Hg: 0.0&h

PDA Detector
Chan ‘i
Chl 214
Chz 214
Ch3 214
Ref. 214

Bw Absorb.
10 0.000000
10 0.000000
10 0.000000
10 0.000000

|Status Idle

Voltage Settings ] Temperature ] Lamp On/CH ] Spectrum | Lamp How 4 | *

v
Inlet Sample Tray
Inlet Buffer Tray
Clutlet Sample Tray
Clutlet Buffer Tray

48 Vials
36 Vial=
96 Positions/MNo Tray
36 Vial=

Home

Load

il

Stop
Advanced

PA 200 Plus

PA 800 Plus Empower" Driver
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Direct Control

Instrument Status in the Direct Control Pane

Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi). The
registry setting for the Waters Empower™ software controls which value is used. The default unit
is millibar. To change the units, refer to the document: PA 800 Plus Empower™ Driver Release
Notes.

Figure 2-2 Instrument Status in the Direct Control Pane (LIF Detector)

Contral Temperature Tray LIF Detector

Violtage  0.000 kV| Cartndge 24.8 °C Bl: Al || Channels RFU

Current  0.000 pA|| Storage 250 °C BO: Al || Chi 0.000000

Power  0.000 W Laser Hrs Ch2 0.000000

Pressure Coolant Lasers 1: 1250 h

00psi o+ OK i & 0.00 h
Label Description
Control Shows the voltage, current, and power.
Temperature Shows the temperature of the cartridge and sample cooling
system.

Tray Shows the location of the capillary inlet and outlet.
LIF Detector Shows information about the LIF detector.

« Channels: The channel for the data, Ch1 and Ch2.

* RFU: The relative fluorescence units of the data in this
channel.

Pressure Shows the direction and the magnitude of the pressure or
vacuum.

+ =: Forward direction
+ <7: Reverse direction
* +: Pressure

e« —:Vacuum

Coolant Shows the status of the coolant, OK or Low.
Lasers (LIF detector) Shows the status of the laser, On or Off.
User Guide PA 800 Plus Empower" Driver
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Direct Control

Label Description
Laser Hrs (LIF detector) Shows the number of hours that the laser has
been on.

* 1: Hours for the integrated 488 nm laser.

« 2: Hours for an external laser, if installed.

Figure 2-3 Instrument Status in the Direct Control Pane (PDA Detector)

Control Temperature Tray FDA Detector

Voltage  0.000 kV| Cartnidge 256 °C Bil: A1 [|Chan ‘Ww Bw Absorb.

Current  0.000 pA| Storage 250 °C BO: -- || Ch1 214 10 0.000000

Power 0 W Lamp Hrs Ch2 214 10 0.000000

Pressure Coolant Lamp D2: 700h|| Ch3 214 10 0.000000
00psi =+ OK On Hg: 006h|| Ref 214 10 0.000000

Note: For items that are common to all detector types, refer to the figure: Figure 2-2.

Label Description
Lamp Shows the status of the lamp, On or Of f.
Lamp Hrs Shows the number of hours that the lamps have been on.

* D2: The number of hours that the deuterium lamp has
been on.

* Hg: The number of hours that the mercury lamp has
been on.

PDA Detector Shows information about the PDA detector.

« Chan: The channel for the data.
* Wv: The wavelength for the channel, in nm.
« Bw: The bandwidth for the channel, in nm.

» Absorb: The absorbance for the channel.

PA 800 Plus Empower" Driver User Guide
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Direct Control

Figure 2-4 Instrument Status in the Direct Control Pane (UV Detector)

Control Temperature

Voltage  0.000 kV || Carrnidge 252 °C

Current  0.000 pd| Storage 250 °C

Power 0.000 ‘w

Pressure Coolant Lamp
0.0 psi o + OK On

Tray W Detector
Bl: Al ||Chan ‘wiv Absorb.
BO: Al || Chl 0 0.000000
Lamp Hrs
D2:  550h
Hg: 0.00h _FI

Note: For items common to all detector types, refer to the figure: Figure 2-2.

Label Description
Lamp Shows the status of the lamp, On or Of£.
Lamp Hrs Shows the number of hours that the lamps have been on.

* D2: The number of hours that the deuterium lamp has
been on.

* Hg: For display only. Not used for the UV detector.

UV Detector

Shows information about the UV detector.
e Chan: The channel for the data.
»  Wv: The wavelength for the channel, in nm.

« Absorb: The absorbance for the channel.

i

Click to see filter information.

Figure 2-5 Instrument Status in the Direct Control Pane (UV Filters)

Control Temperature

Voltage  0.000 kV || Carridge 252 °C

Current  0.000 pd| Storage 250 °C

Power 0.000

Pressure Coolant Lamp
00psi =+ OK Off

Tray IV Filters
B Al |F1:  ---F& 0
BO: A1 |F2Z  20FT: 0
lampHs— F3 214 F8 0
D2 s55pR|f Y B4
280
g 0.00h o

Note: For items common to all detector types, refer to the figure: Figure 2-2.

User Guide
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Direct Control

Label Description

Lamp Refer to the figure: Figure 2-4.

Lamp Hrs Refer to the figure: Figure 2-4.

UV Filters F<x>: Shows the wavelength of the filter in position <x>, in
nm.

o Click to see detector information.

Parameters and Buttons in the Direct Control
Pane

Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi). The
registry setting for the Waters Empower™ software controls which value is used. The default unit
is millibar. To change the units, refer to the document: PA 800 Plus Empower™ Driver Release
Notes.

Figure 2-6 Parameters and Buttons in the Direct Control Pane

Pressure Settings | Violtage Settings ] Temperature ] Lamp Cn/Cff ] La 4 | 4 Home

Pressure (psi) 01
Load
Duration (min) 0.10 —l‘z'FJ
Pressure Direction Forward Set |
w Tray Positions
Sit
Inlet Vial Al —l‘]p
Inlet Tray Buffer Advanced |
Cutlet Vial Al
Cutlet Tray Buffer
P& 200 Plus
Label Description
Parameter Tabs
Pressure Settings Set the pressure for the system.
Voltage Settings Set the voltage for the system.
Temperature Set the temperature for the capillary and sample cooler.
PA 800 Plus Empower" Driver User Guide
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Direct Control

Label Description
Lamp On/Off (UV or PDA detector) Turn the lamp on or off.
Laser On/Off (LIF detector) Turn the laser on or off.

Calibration Factors

(LIF detector) See the calibration correction factors and set
the parameters for detector calibration. Refer to the section:
Calibrate the LIF Detector (Optional).

UV Filters (UV detector) Set the position and wavelength of the filters
installed in the system.
Lamp Hours (UV or PDA detector) After the lamp is replaced, set the

lamp hours to 0.

Lamp Energy

(UV detector) Select the filter in the Filter list, and then click
Set to see the current between the diodes in the deuterium
lamp, in nA. This value decreases over time as the lamp
ages.

Trays See the type of sample and buffer trays in use.

Spectrum (PDA detector) See the spectrum of the deuterium lamp.
Refer to the section: See the Deuterium Lamp Spectrum
and Intensity.

Buttons

vl

Click to open the next or previous tab.

L

Click to open the Help pane.

V)| Click to close the Help pane.
Home Click to move the trays to the home position.
Load Click to move the trays to the load position.
Set Click to send the parameters to the PA 800 Plus system.
* (LIF detector) When the Calibration Factors tab is shown,
this button changes to Start.
* (UV detector) When the Lamp Hours tab is shown, this
button changes to Reset.
+ (PDA detector) When the Spectrum tab is shown, this
button changes to Monitor.
User Guide PA 800 Plus Empower" Driver
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Direct Control

Label Description

Stop Click to turn off the voltage, current, power, pressure, and
cooling.

Advanced (PDA detector) Click to calibrate the PDA detector. Refer to
the section: Calibrate the PDA Detector.

PA 800 Plus Empower" Driver User Guide
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Create an Instrument Method 3

1. In the Waters Empower™ software Project window, click File > New Method > Instrument
Method.

Figure 3-1 Select Desired Chromatography System Dialog

Select Desired Chromatography System >

Fleaze zelect the chiomatographic spstem which pou would like o uge to acquire zamples into thiz project.

Mote that you may hawve access to bwo or more syztems with the zame Syetem Name on different nodes.

Sustern Name | Svztem Location | Mode Mame | Sustern Comments |
Instument 2 Laced inztruments 2 in Dual
Instrument 3 Lace? CE3

QK | Cancel | Help

Click the applicable system name, and then click OK.
3. In the Instrument Method Editor, do this:
a. Open the Detector tab.
b. From the Detector Type list, select the applicable detector.

c. Setthe parameters.
Refer to the section: Detector Parameters for an Instrument Method.

d. Make sure that the system is configured with the correct detector for the application. If
the Detector Type must be changed, then change it before other changes are made to
the instrument method.

Note: When the Detector Type changes, all parameters are set to their default values.

User Guide PA 800 Plus Empower" Driver
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Create an Instrument Method

Figure 3-2 Detector Parameters

General Detector |T|me Program I

— Detector Type PDA ~|

— Blectropherogram Scan Data — Filter
Data Rate |4 vI Hz General Pupose 16-25 -]
Scan Range from |1BD to |3DD nm

— Blectropherogram Channel Data — Relays

Data Rate

=
4
ju
[

Acquire Ref Wi[nm]  Bw[n

El

Chanell [~ I~ f1a  [io
Channel2 [~ [~ |254— |1u—
Chamnel3 I~ T~ 80 [io
Peak Detect. [~ [~ W W

Relay 1 Relay 2
|V IClosed LI |V IGosed LI

r— Reference Channel

‘Wavelength I-H}D nm

Bandwidth IH] nm
— Absorbance Signal

Signal Direct -]

4. Open the General tab, and then set the parameters. Refer to the section: General
Parameters for an Instrument Method.

PA 800 Plus Empower" Driver
16/63
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Create an Instrument Method

Figure 3-3 General Parameters

General ] Detector | Time Program |

Aurdliary Data Channels Peak Detect Parameters
™ Voltage Max:  |20.0 kW Peak Moise Multiplier 2
v Current Max:  |300.0 s Peak Filter \afidth 5 w
Power Max:  [9.000 W
[ Pressure Capillary Settings
[ Cartridge Temperature Capillary Total Length

(%) [=x)
=I=
[=] %]
[x]
=

2]
El

Capillary Length

Trigger Settings

Temperature
I Wait For External Trigger .
Wait for Temperature Cariridge 25.0 £
| Do not wait | Sample Storage 250 C
Inlet Trays Cutlet Trays
Buffer 36 vials - Buffer 36 vials -
Sample 48 vials - Sample m

5. To add events to the time program, open the Time Program tab. Refer to the section: Add
Events to the Time Program for an Instrument Method.

The Waters Empower™ software requires that the last event in the time program is an End
event.

Figure 3-4 Time Program

Geneml] Detector Time Program l

Time {min) Event Walue | Durgtion | Inlet vial | Inlet tray | Outlet vial | Outlet tray Summan|
[ 4 - Finge Pressure j 20.0psi [2.00min |Al Buffer Al Buffer Forward;0;{
0.00 Separate Pre... j 200psi [2.00min |B1 Buffer B1 Buffer Forward;0;{
0.20 Autozero j
200 End ~|
: -

6. To save the instrument method, do this:

a. Click File > Save.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

c. (Optional) In the Method Comments field, type any required information.

User Guide PA 800 Plus Empower" Driver
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Create an Instrument Method

d. Ifa promptis shown, then in the Password field, type the Waters Empower" software
password for the current user, and then click Save.

The instrument method is saved to the active project.

General Parameters for an Instrument Method

Figure 3-5 General Parameters for an Instrument Method

General l Detector | Time Program |

Aundliary Data Channels Peak Detect Parameters
[ Veoltage Max:  |30.0 kv Peak Moise Multiplier 2
v Current Mac:  |300.0 e Pezk Filter Width g |-
Power Max:  |9.000 o/
™ Pressure Capillary Settings
[ Cartridge Temperature Capillary Totsl Length 60.2 cm
Capillary Length W cm
Trigger Settings
Temperature
I Wait For External Trigger _
Wait for Temperature Cartridge 25.0 C
|Dl:| not wait j Sample Storage 25.0 C
Inlet Trays Outlet Trays
Buffer 36 vials - Buffer 36 vials -
Sample 48 vials - Sample No tray -
Label Description
Aukxilliary Data Channels Select more types of data to be collected: Voltage, Current,
Pressure, and Cartridge Temperature.
For Voltage, Current, and Power, type the maximum value to
be applied during data collection.
PA 800 Plus Empower" Driver User Guide
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Create an Instrument Method

Label

Description

Trigger Settings

If the method is triggered by an outside source or device, then
select the Wait For External Trigger check box.

To use a temperature to start the run, select an option:

Do not wait, Wait for Cartridge Temperature, Wait for
Storage Temperature, and Wait for Cartridge and Storage
Temperature.

Inlet Trays

Select the type of sample and buffer trays that are installed in
the inlet positions.

Peak Detect Parameters

Do not change the parameters in this area. They have no effect
on data acquisition.

Capillary Settings

Type the dimensions of the capillary.

Temperature (°C)

Type the temperature for the cartridge and the sample cooler.

Outlet Trays

Select the type of sample and buffer trays that are installed in
the outlet positions.

User Guide
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Create an Instrument Method

Detector Parameters for an Instrument Method

Figure 3-6 Detector Parameters for a PDA Detector

General Detector lTime Program ]

Detector Type PDA +

Blectropherogram Scan Data Fitter

Diata Rate 4 | Hz General Purpose 16-25 j
Scan Range from |‘|5D to |3DD nm

Blectropherogram Channel Data Relays
Relay 1 Relay 2
Data Rate 4 | Hz Closed - Clozed -

Ref Chame
Acquire Ref Wi[nm]  Bw [om] Brenee Lhanne

Channel1 [~ [T \Wavelength 400 am
Channel 2 [~ Bandwidth 10 nm

hik
1717

-
Channel 3 [~ [
Absorbance Signal

-

Peak Detect. [ 250 120
Signal Direct j
Label Description
Detector Type Select the type of detector.

Electropherogram Scan Data | Set the sampling rate of the data to be collected, in Hz, and the
wavelength range to be scanned, in nm.

A higher rate increases the number of data points per peak, but
might cause more noise. The optimal rate is different for each
analyte and is usually found during method development.

Note: The value for Data Rate must be between 25% to 100%
of the Data Rate for the Electropherogram Channel Data.

PA 800 Plus Empower" Driver User Guide
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Create an Instrument Method

Label

Description

Electropherogram Channel
Data

Set the parameters for data collection for as many as three
channels. In the Data Rate field, select the sampling rate for
data collection.

A higher rate increases the number of data points per peak, but
might cause more noise. The optimal rate is different for each
analyte and is usually found during method development.

For each channel, do this:

» To acquire data from this channel, select the Acquire check
box.

+ To subtract reference trace data from the collected data,
select the Ref check box. The reference is a wavelength that
is recorded and subtracted from the data in the wavelength
channel.

» Type the Wavelength of the data to be collected, in nm.

+ Type the Bandwidth of the data to be collected, in nm.

Filter Select the filter to use to decrease noise in the data.
Refer to the section: About the Filter Parameter.
Relays For Relay 1 and Relay 2, select Open or Closed.

Reference Channel

Type the values for the Wavelength and Bandwidth for the
reference channel, in nm.

Absorbance Signal

To show the data as received from the detector, select Direct.

To invert the signal before the data is shown, select Indirect.

User Guide
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Create an Instrument Method

Figure 3-7 Detector Parameters for a LIF Detector

General Detector ]TiITIB Program I
Detector Type i ~
Blectropherogram Channel 1

¥ Acquisition enabled
Acquisition

[ynamic range 100

Fitter

Blectropherogram Channel 2

[~ Acquisition enabled

General Purpose 16-25

Fluorescence Signal

Acquisition
RFU Dynamic range 100 RFU
Fitter
ﬂ General Purpose 16-25 J

Fluorescence Signal

Signal |Direct

Laser fitter description - information only

j Signal |Direct J

Laser fitter description - information only

Excitation wavelength 488 nm Excitation wavelength 635 nm
Emission wavelength 520 Emission wavelength 675 nm
Data rate Relays
Relay 1 Relay 2
Both channels 2 | Hz Closed - Closed -
Label Description
Detector Type Select the type of detector.

Acquisition enabled

Select to enable data acquisition for the channel. Data can be
acquired from one or both channels.

Acquisition Select the upper limit of the data to be collected, in RFU. If
the fluorescence signal is above this limit, then peaks might be
truncated.

Filter

Select the filter to use to decrease noise in the data.

Refer to the section: About the Filter Parameter.

Fluorescence Signal

To show the data as received from the detector, select Direct.

To invert the signal before the data is shown, select Indirect.

PA 800 Plus Empower" Driver
22/63
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Create an Instrument Method

Label

Description

Laser/filter description -
information only

Type the values for the excitation and emission wavelengths, in
nm. These values are kept with the method but are not used for
acquisition.

The laser wavelength and the emission filter installed in the LIF
detector control the excitation and emission wavelengths that
are used for data acquisition.

Data rate

For both channels, select the sampling rate for the LIF data to
be collected, in Hz.

A higher rate increases the number of data points per peak, but
might cause more noise. The optimal rate is different for each
analyte and is usually found during method development.

Relays

For Relay 1 and Relay 2, select Open or Closed.

Figure 3-8 Detector Parameters for a UV Detector

General Detector ]TiITIB Program I

Detector Type Uy -

Blectropherogram Channel Data

Data Rate 4 w| Hz
210 =] om

‘wiavelength

Fitter

General Purpose 16-25 j
Relays
Relay 1 Relay 2
Closed - Closed -

Absorbance Signal

Signal Direct j
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Create an Instrument Method

Label

Description

Detector Type

Select the type of detector.

Electropherogram Channel
Data

Type the values for the Data Rate, in Hz, and the Wavelength,
in nm, for data collection.

A higher rate increases the number of data points per peak, but
might cause more noise. The optimal rate is different for each
analyte and is usually found during method development.

Filter Select the filter to use to decrease noise in the data.
Refer to the section: About the Filter Parameter.
Relays For Relay 1 and Relay 2, select Open or Closed.

Absorbance Signal

To show the data as received from the detector, select Direct.

To invert the signal before the data is shown, select Indirect.

About the Filter Parameter

The following types of noise filters are available. For each type of filter, a peak width can be

specified.

» General Purpose: This is the normal noise filter. It maximizes peak smoothing with limited or
minimal peak distortion and loss of resolution.

+ Max Sensitivity: This filter decreases baseline noise. It maximizes the signal-to-noise ratio,
but might cause peaks to broaden or flatten. Use this for experiments where peaks are
resolved and detection limits or quantitative accuracy is most important.

* Max Resolution: This filter keeps the peak shape, but decreases baseline noise less than

the other filter options.

The peak width is the expected
available:

* None: No filtering is done.

peak width at the base of a peak. The following ranges are

+ <16 points: The noise filter uses the smallest number of points. The result is less smoothing

and more noise.

* 16 - 25 points: The noise filter uses an intermediate number of points.

+ >25 points: The noise filter uses the largest number of points. The result is more smoothing

and less noise.

PA 800 Plus Empower" Driver
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Add Events to the Time Program for an
Instrument Method

The time program is a table of events in an instrument method. The events are done in order,
from top to bottom.

1. Open an instrument method, and then open the Time Program tab.

2. Click the Event list, and then select an event. Refer to the table: Table A-1.

Figure 3-9 Event List in the Time Program Tab

General | Detector Time Program

Time {min) | Evert | Value | Duration

Autozero

Capillary Temperatures
End

Inject Pressure

Inject Pressure Capillary
Inject Vacuum

Inject Voltage

Lasers Off

Fields for the event parameters are shown in the pane below the table.

3. As required, in the fields to the right, type the applicable parameter values. Refer to the
table: Table A-2.

Figure 3-10 Edit Event Parameters on the Time Program Tab

Pressure (psi) 250
Dwwration (=) 100.0
Pressure Direction Forward
w Tray Positions
Inlet Vial Al
Inlet Tray Buffer
Al
Clutlet Tray Buffer
* |ncrement Every Runs[]
Inlet 0
Qutlet 0
Comments
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Create an Instrument Method

Tip! If a value cannot be changed, then it might be in a list. To make a selection from the
list, scroll to the far right to show the Down arrow, and then click the arrow.

4. (Optional) To show the applicable ranges for the parameters, click @
To hide the Help pane, click @

5. (Optional) To add more rows to the time program, right-click a row header, and then select
Insert Row.
The new row is added below the selected row.

6. (Optional) To delete rows from the time program, right-click a row header, and then select
Remove Row.
The row is deleted.

7. If this time program includes any of the Separate events, then add the End event as the last
event in the time program.

8. Save the instrument method:
a. To open the Save current Instrument Method dialog, click File > Save.
b. Inthe Name field, type a name.
c. (Optional) In the Method Comments field, type any required information.

d. Ifa promptis shown, then in the Password field, type the Waters Empower" software
password for the current user, and then click Save.

The instrument method is saved to the current project.

PA 800 Plus Empower" Driver User Guide
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Set the Definition for the Buffer and
Sample Trays

In the Waters Empower™ software, the sample and buffer trays in the PA 800 Plus system

are referred to as plates. The plate definition must be set in the Waters Empower™ software.
To make this process easier, SCIEX supplies the required information in text files that can be
imported.

Note: The plate definitions should have been set when the Waters Empower™ software was
installed. If the list of plates in the Plate Types Name table includes the PA 800 Plus Sample
Tray, PA 800 Plus Buffer Tray, and PA 800 Plus 96 Well Sample Tray, then the plate definitions
have already been set. The procedure is included here for reference.

1. Put the PA 800 Plus Empower™ Driver DVD in the DVD drive.
Note: If the DVD is not available, then use the copies of the files that are included in this
document. Refer to the section: Plate Definition Files. For each file, copy the contents, and
then paste the contents in an individual text file.
2. Click Configure the System.
Figure 4-1 Configuration Management Window: Plate Types
EMPOWER3FR4 as Lisa/Guest - Configuration Manager — O x
&
File Edit View Records Tools Help
) J J J @|| - Fiter By: [Detault | | EditView Update
2 mpower 3 Configuration ‘[_34 Plate Type Name @
U"' Projects 1 | 24 uCfuge tube, 1.5mL
:I::::sms 2 | 24 vial (open access), ZmL
[]__@ Libraries 3 | 384 well, 80uL
A= eCord 4 | 48 uCfuge tube, 0.5mL
----- é Users 5 | 48 vial holder, 2mL
----- User Groups
..MEY User Types il s
R e T ! Jo
.....ﬁ System Audit Trail 8 |96 well (tall), 1mL
..... %, Offline System Audit Trail 9 |95 wel gtal), 2mL
10 | 98 well (tall), 350uL
11 | 96 well w/700uL insert
12 | 98 well, 300 uL
13 | ANSL24Tubel.5mLHolder
14 | ANSK24VialdmLHolder v
For Help, press F1 32 Total
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Set the Definition for the Buffer and Sample Trays

3. To show the plates definitions that are already set, click Plate Types.
4. Create the plate definition for the buffer tray:

a. Right-click the table, and then select Import from Text.

Figure 4-2 Import Plate Type From Text File Dialog

Import Plate Type From Text File >

“Waters can impart a plate type definition from a text file.
Browse to or type in the path and name of the plate twpe file,
then enter the desired name of the new plate type definition.

Flate Type Definition Impart File:

| D:\PABDOPIus Buffer Tray

Mew Plate Type Mame:

| PAB0D Plus Buffer Tray

ak. Cancel

b. Click Browse, and then find and click the PA800P1us Buffer Tray.txt file.

c. Inthe New Plate Type Name field, type PA 800 Plus Buffer Tray, and then click
OK.

The buffer tray is added to the list in the Configuration Manager window.

5. To create the plate definition for the sample trays, do step 4 again.

* For the 48-vial sample tray, find and click the PA800P1us Sample Tray.txt file.In
the New Plate Type Name field, type PA 800 Plus Sample Tray.

» For the 96-well sample tray, find and click the PA800P1lus 96 Well Sample
Tray.txt file. In the New Plate Type Name field, type PA 800 Plus 96 Well
Sample Tray.

Note: The plate definition file for the 96-well sample plate is for a standard SCIEX 96-well
plate (PN 609844). To use a 96-well plate from another manufacturer, in the Configuration
Manager window, click File > New > Plate Type, and then set the plate definition manually.

6. If the Beckman Coulter PACE MDQ Control for Waters Empower™ Software Driver was
previously installed, then delete any plates that were created for use with the driver. Right-
click the row number for the plate, and then select Delete.

PA 800 Plus Empower" Driver User Guide
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Set the Definition for the Buffer and Sample Trays

7. (Optional) To see detailed information about a plate, right-click the row number for the plate,
and then select Properties.

8. (Optional) To delete a plate, right-click the row number for the plate, and then select Delete.

Only plates that were added by a user can be deleted. Plates with preset definitions cannot
be deleted.

9. To close the Configuration Manager, click File > Exit.
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System Maintenance 5

This section gives instructions to use the Waters Empower™ software to change the UV lamp
and to calibrate the PDA and LIF detectors.

For more maintenance procedures, refer to the document: Maintenance Guide.

Change the Detector

1.
2.

In the Waters Empower™ software, close the Run Samples window.

To open the Configuration Manager window, in the Waters Empower™ software Start dialog,
click Configure the System.

To show the available nodes, click Node in the Empower Configuration tree.

Click the row number for the applicable node, and then right-click Bring Offline.

If the system is not in use, that is, if no users are connected to the system or no samples
are being acquired, then the system goes offline. If the system is in use, then a message is
shown.

Close any open programs, and then start the LAC/E module again.

Change the detector. Refer to the document: Maintenance Guide.

For a UV detector, make a note of the positions of any filters that are installed in the UV
source optics assembly.

In the Configuration Manager window, click the row number for the applicable node, and
then right-click Bring Online.

To close the message dialog, click OK.

Do one of the following:

« For a PDA or LIF detector, calibrate the detector. Refer to the section: Calibrate the PDA
Detector or Calibrate the LIF Detector (Optional).

* For a UV detector, continue with step 10.

10. (UV detectors only) Set the filter information:

a. Inthe Direct Control window, click —Fl and then open the UV Filters tab.

b. For each position in the detector where there is a filter, type the wavelength of the filter.
The following table shows the default values.
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Table 5-1 Default Filter Wavelengths for the UV Detector

Position Wavelength
Filter Position 2 200
Filter Position 3 214
Filter Position 4 254
Filter Position 5 280
c. Click Set.

See the Deuterium Lamp Spectrum and Intensity

Use this procedure to see the raw counts from the deuterium lamp as seen by the detector. If the
signal is low, then this procedure can find if the low signal is caused by an issue with the lamp.

The spectrum is a better indicator of lamp life than the Lamp Hours value.

Required Materials
* PDA detector
* OPCAL cartridge (PN 144660)

1. Install the PDA detector. Refer to the section: Change the Detector, and the document:
Maintenance Guide.

2. In the Direct Control pane, open the Lamp On/Off tab.
To turn on the lamp, click On, and then click Set.

4. Open the Spectrum tab. In the Scan Rate list, select 32, and then click Monitor.

Figure 5-1 Spectrum Tab

Ternpemture] Lamp On/Off  Spectrum lLarnp Hnurs] Trays ] | e
Scan Rate: | 32 = Diode: ID_ Count: |D Load

Monitor

Stop

[

Advanced

PA 800 Plus
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When the data is collected, the spectrum is shown.

Figure 5-2 Spectrum Tab with Acceptable Spectrum

Ternpelature] Lamp On/Off Spectrum lLarnp Hnurs] Trays ] alr Flome |

Scan Rate: 32 ~| Diode: ’E Count: |31 324 Load |
"02 Lamp Raw Light Intensity Monitor |

35000 ot |
3000 op
g Advanced |

= 20ml ] .

R '

S s
10000
5000 — !

0 - — S — P4 200 Plus
0 Ed 100 150 200 230
Diode Mumber

5. Examine the spectrum and the value in the Counts field.

» If the value is more than 5,000 and the plot is not flat on top, then the lamp operation is
correct.

+ If the value is less than 5,000, then go to step 6.

+ If the plot is flat on top, then the signal is saturated. In the Scan Rate list, select 64, and
then click Monitor.

If the plot is still flat, then in the Scan Rate list, select 128, and then click Monitor.

Figure 5-3 Spectrum Tab with Saturated Spectrum

Ternpelature] Lamp On/Off Spectrum lLarnp Hnurs] Trays ] alr Flome
Scan Rate: | 32 = Dicde: Iﬁ Count: |62704 Load

"02 Lamp Raw Light Intensity Monitor
80000

Stop
Advanced

80000 | — =

Jids

2000

Count

20000

o | 1 | PAS00PIus

a 30 100 150 200 230

Diode Mumber

6. Examine the cartridge to make sure that:
* The aperture is clean.
* The capillary is clean and not broken.

* The aperture is in the center of the capillary window.

PA 800 Plus Empower" Driver User Guide
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* The fiber-optic cable is clean and not broken.

7. Inthe Scan Rate list, select 32, and then click Monitor.
In the Counts field, if the value is still less than 5,000 at 32 Hz, then go to step 8.

Install the OPCAL cartridge.

9. Inthe Scan Rate list, select 32, and then click Monitor.
In the Counts field, if the value is less than 10,000, then replace the lamp. Refer to the
section: Change the Deuterium Lamp.

Change the Deuterium Lamp

Required Materials

* Deuterium lamp
* 7/64 inch hex key

» Powder-free gloves

WARNING! Hot Surface Hazard. Before a lamp is replaced, turn off the power to the
system, and then let the lamp cool fully. A hot lamp will cause burns.

CAUTION: Potential Wrong Result. Before the deuterium lamp is installed, make sure
that an orange O-ring is installed on the lamp flange. A missing O-ring decreases lamp
performance.

CAUTION: Potential System Damage. Do not touch the envelope of the lamp. Oils from
skin can cause damage to the lamp.

CAUTION: Potential System Damage. Use powder-free gloves to touch the UV lamp. UV
lamp operation generates high temperatures and strong UV intensity. In these conditions,
fingerprints make corrosive compounds that etch the surface of the UV lamp and can
cause it to break when it is turned on. Keep the UV optical window dry and protect it from
abrasion.

The deuterium lamp is used by the UV and PDA detectors. If the baseline shows too much noise
or the lamp does not illuminate, then the deuterium lamp might need to be replaced.

1. Open the cartridge cover.

2. Turn off the power to the system, and then let the deuterium lamp cool.

3. Loosen the two thumbscrews on the insertion bar, and then lift the insertion bar.
4

Remove the capillary cartridge from the interface block.
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5. Loosen the two thumbscrews on the optics source assembly.

Figure 5-4 Optics Source Assembly

0
[

L. H r"_'\ | -\
® |
o iy ‘ o 1e=(3)
B ‘ e o7
Item Description

1 Access cover latch

2 Access cover

3 Thumbscrews (one on each side)

Pull forward to remove the optics source assembly.
7. Put the assembly on a clean work surface.

Open the access cover on the back of the optics source assembly, and then disconnect the
power connector.

PA 800 Plus Empower" Driver User Guide
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10.

11.
12.
13.

14.
15.
16.
17.
18.

Figure 5-5 Deuterium Lamp Assembly

Item Description

1 Power connector

Use a 7/64 inch hex key to remove the two screws that hold the deuterium lamp in position,
and then remove the lamp from the lamp housing.

To install the new deuterium lamp, align the flange guide notch in the lamp with the housing
guide pin.

Install the two hex screws, and then tighten them.
Connect the power plug to the optics source assembly, and then close the access cover.

Put the optics source assembly in the mounting location, align the two upper guide pins, and
then tighten the two thumbscrews.

Install the capillary cartridge in the interface block.

Lower the insertion bar, and then tighten the two thumbscrews.
Close the cartridge cover.

Turn on the power to the system.

Reset the lamp hours in the Waters Empower™ software:

a. Start the Waters Empower™" software.

b. Inthe Direct Control pane, click Lamp Hours, and then click Reset.
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Calibrate the PDA Detector

To make sure that the analysis results are consistent over time, calibrate the PDA detector after
the PDA detector is installed, after a different cartridge is installed, and after a new capillary is

installed in the cartridge.

1. Turn off the PA 800 Plus system.
2. Install the PDA detector.

Refer to the document: Maintenance Guide.

Turn on the PA 800 Plus system, and then let the lamp warm up for at least 30 minutes.

4. Open the Waters Empower™ software, and then click Run Samples.
The Direct Control pane shows in the Run Samples window.

Note: If the Direct Control pane does not show, then click View > Control Panels > SCIEX

CE.

Figure 5-6 Direct Control Pane for PDA Detector

Control Temperature Tray PDA Detector
Voltage  0.000 kV|| Cartridge 256 °C Bl: Al W Bw  Absorb.
Current  0.000 pb| Storage 250 °C BO: 214 10 0.000000
Power 0 W Lamp Hrs 214 10 0.000000
Pressure Coolant Lamp 0D2: 700h 214 10 0.000000
00psi =+ 0K On Hg: 006h 214 10 0.0000DD
|Status Idie

Voltage Settings I Temperature I Lamp On/Cff | Spectrum | Lamp Houw 4 | *

v
Inlet Sample Tray 48 Vials
Inlet Buffer Tray 36 Vials
Outlet Sample Tray 96 Positions/No Tray
Outlet Buffer Tray 36 Vials

5. In the Direct Control pane, click Advanced.
The window changes to show more parameters.

Home

Load

Stop
Advanced

i

PA 800 Plus
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Figure 5-7 PDA Detector Calibration Parameters

Electropherogram Channel Data Absorbance Signal

Ref Wil [nm] Bw [nm] | Direct

Channel 1 I 214 10 =
itter
Channel 2 [ |254 10 |Genem| Pumpose 16-25 ﬂ
Channel 3 B 280 10 Shutter
Peak Detect. [~ [25p 120 |GDSEI:| j
Reference Channel
Apply |
‘wiavelength 400 nm
Cancel |
Bandwidth 10 nm |

Calibrate

|Status

6. Click Calibrate. Do not change any of the parameters.
The calibration starts. When the calibration is complete, the status field shows 87: PDA
Wavelength calibration successful!, where 87 is the message code.

7. If the calibration is unsatisfactory, then do this:
a. Remove the cartridge and detector.
b. Install the cartridge and detector again.
c. Do step 3 through step 6.

If the calibration is unsatisfactory a second time, then do this step again.

If the calibration is unsatisfactory again, then contact SCIEX Technical Support at
sciex.com/request-support.

Calibrate the LIF Detector (Optional)

This procedure is optional. If there is a requirement for consistency from system to system or
cartridge to cartridge, then do this procedure.

Calibrate the LIF detector after the LIF detector is installed, after a different cartridge is installed,
or after a new capillary is installed in the cartridge.

Note: The following procedure technically does normalization, not calibration. Normalization
uses a measured quality, such as the fluorescence of the LIF Performance Test Mix. Calibration
uses an external standard. Because the software user interface uses the term calibration, that
term is used in this guide.

For the best results, we recommend the use of the following:
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RUO-IDV-03-9721-B 37/63


https://sciex.com/request-support

System Maintenance

+ The same capillary that will be used for the separations

* For each system, a dedicated LIF aperture and probe guide

Required Materials

* LIF Performance Test Mix
 CE Grade Water

Turn off the PA 800 Plus system.
Install the LIF detector.

Turn on the PA 800 Plus system, and then turn on the solid-state laser.

A\

Open the Waters Empower™ software.

Figure 5-8 Waters Empower™ software Pro Interface Window

Empower on EMPOWER3IFR4 as Lisa/Guest

o Configure the System

Perform administrative tasks in configuration manager.

Run Samples
Select Project and Chromatographic systems to acquire data.

o Browse Projects

View and select Project to open.

@ Logout @ Login new user

5. Click Run Samples. If required, then log in.
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Figure 5-9 Run Samples Dialog

Run Samples *
Project in which to acquire data: Chromatographic Systems
E|" Projects ~  Usze 'Run Samples' to run new samples ::":' |'-l=5= 713 -3 :
#-{&] 09202019 ECE EVELUATION at yaur ok station. Lz honbohs (2 Lace
-G P& 800PIus Rohs (@ Lacel

-] 1.3 DRIVER
;% CIEF-FR-2019 Select the desired project and system
- fram the dizplayed lists.

El Firdous 2019
(8] CIEF_UW_ANALYSIS ‘wihen in the Flun 5 amples Windaw,
{3 Develop 2019 uze the system control panel to
.. Diriver 1.3 Sprint 8 equilibrate your system, or uze the
E% EE\I—;EI Dszlar.:r; Buil Sample SetWizard to lead vou through
an ul the process of creating a Sample Set to
~{&] ECE_CIEF_UY b run on the system,

{3 ECE_SDS_LIF
% :EEGEfDi 2 SD_1P9DA Uze QuickStart
q

@ LIFDETECTOR CALIBRATION
{5 Merv Testing W Ok, | Cancel | Help |

On the left, click the folder for the project of interest.
On the right, click the system that has the LIF detector installed, and then click OK.
In the Direct Control pane, click Load.

In the buffer outlet tray, put a universal vial in position A1.

> © ® N o

0. In the buffer inlet tray, put universal vials in positions A1 and B1.

Note: To prevent splashing, put the empty vials in the tray, and then add liquid and attach
the caps.

11. Fill the vials, and then put caps on the vials:
* Inlet buffer tray position A1: 1.5 mL of CE Grade Water
* Inlet buffer tray position B1: 1.5 mL of LIF Performance Test Mix
+ Outlet buffer tray position A1: 1.0 mL of CE Grade Water

12. Set the parameters, and then start the calibration:

a. Inthe Direct Control pane, open the Calibration Factors tab, and then click Auto.
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Figure 5-10 Direct Control Pane: Calibration Factors Tab

Voltage Settings I Temperature I Lasers On/Off Calibration Factors l L

Please enter the following calibration parameters:
Detector channel: w1 32

Target RFU value: 15 RFL
Capillary dimensions

Internal diameter: 300 Lm

Total length: 55.0 cm

&

b. Click the Detector channel to be calibrated.

c. Inthe Target RFU value field, type the recommended RFU value.

Refer to the following table.

Haoi
Load
Start

did;

Stop

" Manual
* Auto

PA 800 Plus

Table 5-2 Recommended Target RFU by Capillary Type

Type of Capillary Internal Total Length Recommended
Diameter (um) (cm) Target RFU

Bare fused-silica 50 User specified 15

Bare fused-silica 75 User specified 35

DNA 100 User specified 62

N-CHO 50 User specified 7

d. Type the values for the Internal diameter and Total length of the capillary.

e. Click Start.

Figure 5-11 Vial positions Dialog

Vial positions

following positions:
Inlet Al:  Buffer
Inlet B1:  Calibration Mix
Outlet Al: Waste
Do you want to continue?

You are about to start LIF Calibration. Please check the appropriate vials are in the

Mo
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13.

14.

15.

f.  Click Yes.

The calibration starts and requires approximately 9 minutes to complete. The
Calibration Complete! message is shown.

If the message No step change detected is shown, then the detector cannot detect the
solution. For troubleshooting procedures, refer to the section: No Step Change Detected.
Figure 5-12 Calibration Factors Tab After Calibration

Voltage Settings ] Temperature ] Lasers On/Off  Calibration Factors ]' il Ho
Calibration Complete!

me

i

Load
Detector channel: w1 2 5

CCF: 121 “oeed

L

Cancel

" Manual
* Auto

PA 800 Plus

Examine the value in the CCF field:

« If the CCF value is less than 0.1, then click Cancel. Refer to the section: CCF Values for
LIF Detector Calibration.

« |f the CCF value is between 0.1 and 10, then the calibration was successful. Click
Accept to save the results.

Note: If the samples will be labeled with a dye other than fluorescein, then we
recommend that a standard be run to make sure that the system performance is
satisfactory.

« If the CCF value is more than 10, then click Cancel. Refer to the section: CCF Values for
LIF Detector Calibration.

If the system will be used immediately for separation, then on the Temperature tab, set the
sample storage temperature to a value that is correct for the samples to be run.

By default, after the calibration completes, the sample storage temperature is set to 25 °C.

Close the Direct Control pane.
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Troubleshoot the LIF Detector Calibration
CCF Values for LIF Detector Calibration

System performance is
not satisfactory

Issue Action

Reported CCF value is |+ Make sure that the correct capillary was used, and that it is not
less than 0.1 broken.

or * Make sure that the laser output for the laser in use on the system is

correct.

Make sure that the correct filters are installed in the LIF detector:

« Excitation: 488 nm
e Emission: 520 nm

Replace the test mix, buffer, and capillary, and then do the
calibration again. If the issue continues, then contact SCIEX
Technical Support at sciex.com/request-support.

Reported CCF value is
between 0.1 and 10.0

There is no issue with the system. Run a standard and make sure that
the system performance is satisfactory.

Reported CCF value is
more than 10

or

System performance is
not satisfactory

Make sure that the laser output for the laser in use on the system is
correct.

Make sure that the correct filters are installed in the LIF detector:

» Excitation: 488 nm
e Emission: 520 nm

Replace the test mix, buffer, and capillary, and then do the
calibration again. If the issue continues, then contact SCIEX
Technical Support at sciex.com/request-support.

No Step Change Detected

The LIF calibration compares detector signals from a nonfluorescent solution and a known
fluorescent solution. When a rinse with nonfluorescent solution is done and then followed by a
rinse with fluorescent solution, the first part of the detector signal should be near zero and the
second part should be near the target fluorescent value. This detector output is in the shape of
a step and is referred to as a step change. If a step change is not seen, then the applicable
solutions are not passing the detector or the detector cannot detect the solutions.

1.  Make sure that the switch on the right side of the laser is in the ON position.

2. Make sure that the laser that was supplied with the system is connected and the LASER ON

light is illuminated.
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3. To make sure that the solution goes through the capillary, from buffer inlet position A1 to
an empty buffer vial in outlet position B1, use Direct Control to do a pressure rinse with CE
Grade Water at 20 psi for 5 minutes.

4. When the rinse starts, open the sample cover. Look at the outlet end of the capillary in
position B1.

» If there are droplets on the outlet end of the capillary, then do step 6.

» If there are no droplets on the outlet end of the capillary, then the capillary is blocked or
the system has a pressure failure. Continue with the next step.

5. Replace the capillary, and then do the pressure rinse again.

» If there are still no droplets on the outlet end of the capillary, then contact SCIEX
Technical Support at sciex.com/request-support.

» If there are droplets on the outlet end of the capillary, then the detection system is the
only possible cause. Continue with the next step.

6. Make sure that the correct filters are installed in the LIF detector.

If no step change is detected, then do the calibration procedure again. Refer to the section:
Calibrate the LIF Detector (Optional).

If the calibration procedure has been done more than 3 times, then manually set the
calibration correction factor (CCF) to 1.0, and then calibrate the LIF detector again.

If the LIF detector calibration continues to fail, then contact SCIEX Technical Support at
sciex.com/request-support.
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Troubleshooting

Symptom

Possible Cause

Corrective Action

The Instrument Failure
message or the System
Error message is shown

in the Waters Empower™
software Message Center
window.

1. The incorrect version
of the GPIB driver is
installed.

2. The incorrect version
of the .NET Language
Runtime is installed.

1. If the National Instruments
GPIB driver Version 19.0
is not installed, then install
it.

2. If1-488.2 .NET Language
Runtime 17.0.1 for NET
Framework 4.5 is not
installed, then install it.

After the detector is changed,
the Instrument Failure
message or the System
Error message is shown

in the Waters Empower™
software Message Center
window.

After a new detector is
installed, the firmware settings
were not downloaded from
the PA 800 Plus system to

the LAC/E module or the
Instrument Server does not
have the new settings.

Start the PA 800 Plus
system again, and then start
the LAC/E module or the
computer that is physically
connected to the system.

The results for the assay

are very different than the
results shown in the document
Application Guide.

The parameters in the
instrument method are
incorrect.

Examine the instrument
method and make sure that:

* The pressure is applied
to the correct side of the
capillary or both sides.
Refer to the applicable
document: Application
Guide.

* The pressure values are
correct for the units
used by the software,
either millibar or psi. For
instructions about how to
change the pressure units
used in the software, refer
to the document: PA 800
Plus Empower™ Driver
Release Noftes.
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Troubleshooting

Symptom

Possible Cause

Corrective Action

The results of some data
processing calculations are
very different than the results
for similar calculations in the
32 Karat software.

Some of the

capillary electrophoresis-
related calculations in the
Waters Empower™ software
are not optimized for SCIEX
systems.

Create a custom calculation
for CE-specific attributes such
as velocity corrected area
(VCA).

Pressure or movement errors
occur when the vials should
be incremented during a run.

The Sample Set method is not
correct.

Make sure that the vial
increment number agrees with
the number of lines in the
sample set method and is the
same as the number of runs in
the sample set method.

The Scan or Channel
Data Overflow error
messages during data
acquisition.

Because more than one PA
800 Plus system is connected
to the LAC/E module, too
much data is collected.

Do not acquire data on both
systems at the same time.
Connect each system to a
separate LAC/E module.
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Time Program Events

A

This section gives a list of events and the related parameters that can be added to a time
program in an instrument method. Refer to the table: Table A-1.

For details about the parameters, refer to the table: Table A-2.

Note: The Comment parameter is not included in the following table but is available for every

event.

Table A-1 Time Program Events

Event Description Parameters

Auto Zero Zero the detector output. At Time (min)
Capillary Set the capillary temperature. * Temperature (°C)
Temperature . At Time (min)
End Identify the end of the method. Only one At Time (min)

End event is permitted in a method. The
End event must be the last event in the time
program.

Inject Pressure

Use pressure to inject the sample.

* Pressure (psi or
mbar)

* Duration (s)
* Pressure Direction
» Tray Positions

* Increment Every
Runs

Inject Pressure
Capillary Fill

Use pressure to inject the sample.

This event uses a higher pressure and a
longer duration than the Inject Pressure
event. Use this event to completely fill the
capillary with sample.

* Pressure (psi or
mbar)

* Duration (s)
* Pressure Direction
» Tray Positions

* Increment Every
Runs
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Time Program Events

Table A-1 Time Program Events (continued)

Event

Description

Parameters

Inject Vacuum

Use vacuum to inject the sample.

Vacuum (psi or mbar)

Duration (s)

Pressure Direction

Tray Positions

Increment Every
Runs

Inject Voltage

Use voltage to inject the sample.

Voltage (kV)
Polarity
Duration (s)
Tray Positions

Increment Every
Runs

Lamp Off Turn off the lamp at the specified time. At Time (min)
Lamp On Turn on the lamp at the specified time. At Time (min)
Lasers Off (LIF detector) Turn off the lasers at the At Time (min)
specified time.
Lasers On (LIF detector) Turn on the lasers at the At Time (min)
specified time.
Relay On Turn on the specified relays at the specified [+ Relay 1
time. . Relay 2
* At Time (min)

Rinse Pressure

Add a Rinse event that uses pressure.

Pressure (psi or
mbar)

Duration (min)

Pressure Direction

Tray Positions

Increment Every
Runs

At Time (min)
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Time Program Events

Table A-1 Time Program Events (continued)

Event Description Parameters

Rinse Vacuum Add a Rinse event that uses vacuum. * Vacuum (psi or mbar)
* Duration (min)

* Pressure Direction

* Tray Positions

* Increment Every
Runs

* At Time (min)

Sample Storage Set the temperature of the sample cooler. * Temperature (°C)
Temperature . AtTime (min)

Separate Current Use current to separate the sample. + Current (uA)

* Duration (min)

* Ramp Time (min)
* Tray Positions

* Increment Every
Runs

* At Time (min)

Separate Current Use current and pressure to separate the * Current (UA)

Pressure sample. . .
* Duration (min)

* Ramp Time (min)

* Pressure (psi or
mbar)

* Pressure Direction
» Tray Positions

* Increment Every
Runs

+ At Time (min)
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Time Program Events

Table A-1 Time Program Events (continued)

Event Description Parameters
Separate Current Use current and vacuum to separate the » Current (uA)
Vacuum sample.

* Duration (min)

* Ramp Time (min)

* Vacuum (psi or mbar)
* Pressure Direction

* Tray Positions

* Increment Every
Runs

* At Time (min)

Separate Power Use power to separate the sample. * Power (W)

* Duration (min)

* Ramp Time (min)
* Tray Positions

* Increment Every
Runs

* At Time (min)

Separate Power Use power and pressure to separate the + Power (W)

Pressure sample. : .
* Duration (min)

* Ramp Time (min)

* Pressure (psi or
mbar)

* Pressure Direction
* Tray Positions

* Increment Every
Runs

* At Time (min)
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Time Program Events

Table A-1 Time Program Events (continued)

Event Description Parameters
Separate Power Use power and vacuum to separate the * Power (W)
Vacuum sample.

Duration (min)

Ramp Time (min)
Vacuum (psi or mbar)
Pressure Direction
Tray Positions

Increment Every
Runs

At Time (min)

Separate Pressure |Use pressure to separate the sample.

Pressure (psi or
mbar)

Duration (min)
Pressure Direction
Tray Positions

Increment Every
Runs

At Time (min)

Separate Vacuum Use vacuum to separate the sample.

Vacuum (psi or mbar)
Duration (min)
Pressure Direction
Tray Positions

Increment Every
Runs

At Time (min)
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Time Program Events

Table A-1 Time Program Events (continued)

Event Description Parameters
Separate Voltage Use voltage to separate the sample. + Voltage (kV)
* Polarity

* Duration (min)
* Ramp Time (min)
» Tray Positions

* Increment Every
Runs

+ At Time (min)

Separate Voltage Use voltage and pressure to separate the » Voltage (kV)

Pressure sample. .
+ Polarity

* Duration (min)

* Ramp Time (min)

* Pressure (psi or
mbar)

* Pressure Direction
* Tray Positions

* Increment Every
Runs

* At Time (min)
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Time Program Events

Table A-1 Time Program Events (continued)

Event

Description

Parameters

Separate Voltage
Vacuum

Use voltage and vacuum to separate the
sample.

Voltage (kV)
Polarity
Duration (min)

Ramp Time (min)

Vacuum (psi or mbar)

Pressure Direction
Tray Positions

Increment Every
Runs

* At Time (min)
Stop Data Stop data collection. At Time (min)
Wait Add a Wait event. * Duration (min)

Tray Positions

Increment Every
Runs

At Time (min)

Wavelength PDA
Detector

(PDA detector) Change the wavelength for
the specified channel in the PDA detector.

Note: The wavelength range (wavelength +'%
bandwidth) must be between 186 nm and
604 nm.

Channel
Wavelength (nm)
Bandwidth (nm)
At Time (min)

Wavelength UV
Detector

(UV detector) Change the wavelength for
Channel 1 in the UV detector.

Wavelength (nm)

* At Time (min)
Parameters for Time Program Events
The parameters are given in alphabetic order.
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Time Program Events

Table A-2 Parameters for Time Program Events

Parameter Details

At Time (min) The time to start this event, given as the time from the first event
with the At Time parameter equal to 0.

Bandwith (nm) (PDA detector) The bandwidth for a Wavelength PDA Detector

event, from 6 nm to 252 nm.

Note: The wavelength range (wavelength 2 bandwidth) must be
between 186 nm and 604 nm.

Channel (PDA detector) The channel in the PDA detector to be set to the
specified wavelength.

Current (pA) The current to be applied during the event, from either —300.0 pA to
3.0 yA or 3.0 pA to 300.0 pA.

» Values from —300.0 pA to —3.0 YA have reverse polarity (— at the
inlet and + at the outlet).

+ Values from 3.0 pA to 300.0 pA have normal polarity (+ at the
inlet and — at the outlet).

Duration (s or min) The duration of the event.

Note: For pressure and vacuum events, the duration must be
sufficiently long to let the system to get to the specified pressure
(or vacuum). Refer to the section: About the Duration for Pressure
and Vacuum Events.

Increment Every Runs | The number of runs after which the inlet and outlet vials should
increment. If the vial should not increment, then type 0. Refer to the
section: About Vial Incrementing.

Polarity The direction of the current to be applied during the event. Options
are:

* Normal (+): + at the inlet and — at the outlet.

* Reverse (-): — at the inlet and + at the outlet.
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Time Program Events

Table A-2 Parameters for Time Program Events (continued)

Parameter

Details

Power (W)

The power to be applied during the event, from —9.000 W to
9.000 W.

» Values from —9.000 W to -0.001 W have reverse polarity (— at the
inlet and + at the outlet).

* Values from 0.001 W to 9.000 W have normal polarity (— at the
inlet and + at the outlet).

Pressure (psi or mbar)

The pressure to be applied during the event.

Note: The system requires time to get to the specified pressure. If
the Duration parameter is too short, then the system cannot get to
the specified pressure. Refer to the section: About the Duration for
Pressure and Vacuum Events.

Pressure Direction

The direction of the pressure to be applied during the event. Options
are:

 Forward: From inlet to outlet.
* Reverse: From outlet to inlet.

« Simultaneous: In both directions at the same time.

Ramp Time (min)

The time required for the system to get to the specified pressure,
voltage, power, or current.

Relay 1

The relay to be opened or closed.

Relay 2

The relay to be opened or closed.

Temperature (°C)

The temperature for the cartridge or sample cooler.

Tray Positions

The inlet and outlet vials for the event. For each vial, identify a tray
and a position. Refer to the section: About Tray Positions.

Vacuum (psi or mbar)

The vacuum to be applied during the event, from 0.1 psi to 5.0 psi
(or 6.9 mbar to 344.7 mbar).

Note: The system requires time to get to the specified vacuum. If
the Duration parameter is too short, then the system cannot get to
the specified vacuum. Refer to the section: About the Duration for
Pressure and Vacuum Events.
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Time Program Events

Table A-2 Parameters for Time Program Events (continued)

Parameter

Details

Voltage (kV)

The voltage to be applied during the event, from —30.0 kV to 30 kV
for any of the Separation Voltage events and —10.0 kV to 10 kV for
the Inject Voltage event.

The Polarity parameter sets the direction of the voltage.

Wavelength (nm)

The wavelength for the event, from 190 nm to 600 nm.

About the Duration for Pressure and Vacuum Events

The system requires time to get to the specified pressure (or vacuum). If the duration is too
short, then the system cannot get to the specified pressure or vacuum. Use the following tables
to make sure that the duration is sufficiently long.

Table A-3 Required Duration to Get to the Specified Pressure

To get to this pressure... Set the duration to at least...
0.1 psi 6.9 mbar 1.0 sec
0.2 psi 13.8 mbar 1.5 sec
0.3 psi 20.7 mbar 2.0 sec
0.4 psi 27.6 mbar 2.5 sec
0.5 psi 34.5 mbar 3.0 sec
0.7 psi 48.3 mbar 3.4 sec
2.0 psi 137.9 mbar 3.5 sec
5.0 psi 344.7 mbar 3.8 sec
9.5 psi 655.0 mbar 5.0 sec
25.0 psi 1723.7 mbar 6.3 sec

Table A-4 Required Duration to Get to the Specified Vacuum

To get to this vacuum... Set the duration to at least...
0.10 psi 6.9 mbar 2.0 sec
0.15 psi 10.3 mbar 2.5 sec
0.30 psi 20.7 mbar 3.0 sec
0.40 psi 27.6 mbar 3.5 sec
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Time Program Events

Table A-4 Required Duration to Get to the Specified Vacuum (continued)

To get to this vacuum... Set the duration to at least...
0.50 psi 34.5 mbar 4.0 sec

About Tray Positions

The following Tray Positions parameters are used to identify the positions of the capillary inlet
and outlet for Rinse, Inject, Separate, and Wait events:

* Inlet Vial: The inlet vial for the next event, from A1 to F6.

* Inlet Tray: The inlet tray for the next event, either Buffer or Sample. For Inject events,
Sample List is also available. Refer to the section: Sample Vial Positions for Inject Events.

» Outlet Vial: The outlet vial for the next event, from A1 to F6.

+ Outlet Tray: The outlet tray for the next event, either Buffer or Sample. For Inject events,
Sample List is also available. Refer to the section: Sample Vial Positions for Inject Events.

In the PA 800 Plus system, the geometry of the sample and buffer trays and the dimensions

of the capillary cartridge control the access to all 36 positions in the tray. For example, if the
capillary inlet is in position A6 in the buffer inlet tray, then the capillary outlet cannot get access
to position F6 in the buffer outlet tray. These incompatible positions are referred to as tray
collisions or vial collisions.

The software makes sure that the tray positions are satisfactory. If a collision is possible, then a
warning message is shown.

The following table shows column combinations that do not cause a collision.

Table A-5 Inlet and Outlet Column Combinations That Do Not Cause a Collision

Inlet Columns Compatible Outlet Columns
AtoF AtoC
BtoF AtoD
CtoF Ato E
DtoF AtoF

Sample Vial Positions for Inject Events

The Inject event is used to inject the sample into the capillary before the separation starts. The
positions of the vials that contain the sample for Inject events can be specified in the instrument
method or in the sample set method.
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Time Program Events

1. To set the vial positions in the instrument method, edit the Tray Positions parameter for any
Inject event.

2. To set the vial positions in the sample set method, do the following:

a. Inthe instrument method, select Sample List for the Inlet Tray in the Tray Positions
parameter.

b. Inthe sample set method, edit the vial positions in the Plate/Well field.

About Vial Incrementing

Vial incrementing is an automated process in which the system moves the inlet and outlet vials
forward after a specified number of method cycles. Vial incrementing removes the need to
create new methods when different vial positions are required during a set of instrument runs.
One method can be used to change to new vial positions automatically.

If vial incrementing is not used, then vials might overflow with liquid that collects in the interface
block, pressure manifold, and other parts of the system. Vial incrementing also helps to prevent
the depletion of the ionic strength of the buffer.

Vial incrementing can be set for either or both of the inlet and outlet vials.

To use vial incrementing, type a value for number of runs in the Inlet and Outlet fields of the
Increment Every Runs parameter. Runs are the number of times a method set is done before
vial incrementing occurs.

When the sample set method advances to a new method set, vial incrementing starts again.
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Plate Definition Files B

This section includes the plate definitions for the buffer tray, sample tray, and SCIEX 96-well
sample tray. These plate definitions must be set in the Waters Empower™ software.

The definition files should be installed as part of the PA 800 Plus Empower™ Driver installation. If
the definition files are missing and the plates require a definition, then copy the text, paste itin a
text editor, and then save the file.

PA800PIlus Sample Tray Plate Definition File

Empower Profile for Plate Type: CE Sample Tray
Plate Type: XY
Permanent: No
Plate Terminology: Plate
Well Terminology: Well
Plate Dimensions:
X: 85.00
Y: 128.00
Height: 17.00
Well Dimensions:
Top Left Well X Location: 9.00
Top Left Well Y Location: 17.10
Well Diameter: 12.00
Well Depth: 14.00
Row and Column Dimensions:
Number of Rows: 8
Row Spacing: 13.40 mm
Number of Columns: 6
Column Spacing: 13.40 mm

Row and Column Offsets:
Row Offset Type: None
Row Offset: 0.00 mm
ColumnOffset Type: None
Column Offset: 0.00 mm

Origin: Bottom Left

Scheme:

Referencing: XY

Horizontal: ABC

Vertical: 123

Sequential Continuous: Off
Horizontal First Priority: On
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Plate Definition Files

PA800PIus 96 Well Sample Tray Plate Definition
File

Empower Profile for Plate Type: 96-Well Sample Tray
Plate Type: XY
Permanent: No
Plate Terminology: Plate
Well Terminology: Well
Plate Dimensions:
X: 85.00
Y: 128.00
Height: 17.00
Well Dimensions:
Top Left Well X Location: 11.00
Top Left Well Y Location: 14.50
Well Diameter: 6.80
Well Depth: 14.00
Row and Column Dimensions:
Number of Rows: 12
Row Spacing: 9.00 mm
Number of Columns: 8
Column Spacing: 9.00 mm

Row and Column Offsets:
Row Offset Type: None
Row Offset: 0.00 mm
ColumnOffset Type: None
Column Offset: 0.00 mm

Origin: Bottom Left

Scheme:

Referencing: XY

Horizontal: ABC

Vertical: 123

Sequential Continuous: Off
Horizontal First Priority: On
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Plate Definition Files

PA800PIus Buffer Tray Plate Definition File

Empower Profile for Plate Type: CE Buffer Tray
Plate Type: XY
Permanent: No
Plate Terminology: Plate
Well Terminology: Well
Plate Dimensions:
X: 85.00
Y: 85.00
Height: 17.00
Well Dimensions:
Top Left Well X Location: 9.00
Top Left Well Y Location: 9.00
Well Diameter: 12.00
Well Depth: 14.00
Row and Column Dimensions:
Number of Rows: 6
Row Spacing: 13.40 mm
Number of Columns: 6
Column Spacing: 13.40 mm

Row and Column Offsets:
Row Offset Type: None
Row Offset: 0.00 mm
ColumnOffset Type: None
Column Offset: 0.00 mm

Origin: Bottom Left

Scheme:

Referencing: XY

Horizontal: ABC

Vertical: 123

Sequential Continuous: Off
Horizontal First Priority: On
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Topics for Familiarization C

During installation, the SCIEX field service employee (FSE) should have familiarized or reviewed
the following procedures with the customer:

« Software functions:

How to install the USB license key

How to create, edit, and save instrument methods

How to configure the software to use multiple plates
How to use Direct Control and the following components:
* Instrument status

+ Status field

+ Parameter tabs and buttons

How to run a single sample or a sample set method

How to stop a run

+ How to view error messages in the Waters Empower™ software Message Center window

* How to install a cartridge

* How to load samples

» For systems with more than one detector, how to change the detectors

+ Maintenance procedures
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Contact Us

Customer Training

* In North America: NA.CustomerTraining@sciex.com
* In Europe: Europe.CustomerTraining@sciex.com

« OQutside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

+ SCIEX Now Learning Hub

Purchase Supplies and Reagents

Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, Canada, United Kingdom, Belgium, Netherlands, France,
Germany, and Switzerland have access to the online store, but access will be extended to other
countries in the future. For customers in other countries, contact a local SCIEX representative.

SCIEX Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

+ sciex.com/contact-us

» sciex.com/request-support

Cybersecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation

This version of the document supercedes all previous versions of this document.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.
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Contact Us

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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